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ВСТУП 

 

Мета дисципліни "Менеджмент проектів програмного 

забезпечення" − показати проектний підхід до розробки програмних 

засобів та навчити студентів використовувати на практиці основні 

методи, інструменті та засоби керування проектами. 

Внаслідок виконання лабораторних робіт з дисципліни студенти 

повинні вміти: розробляти загальний план проекту, що вимагає 

значного об’єму робіт; ефективно оцінювати проектні витрати; 

вимірювати прогрес проекту, продуктивність та інші аспекти процесу 

розробки програмного забезпечення; використовувати метод 

засвоєного об’єму для аналізу вартості; динамічно регулювати плани 

проекту; використовувати засоби керування змінами та системи 

призначення завдань в проектах з розробки програмного 

забезпечення. 

Звіт з лабораторних робіт повинен містити змістовний аналіз 

отриманих результатів та висновки.  

Під час співбесіди студент повинний виявити знання про мету 

роботи, по теоретичному матеріалу, про методи виконання кожного 

етапу роботи, по змісту основних розділів розробленого звіту з 

демонстрацією результатів на конкретних прикладах.  

Студент повинний вміти правильно аналізувати отримані 

результати. Для самоперевірки при підготовці до виконання і здачі 

роботи студент повинний відповісти на контрольні питання, приведені 

наприкінці відповідної роботи.  

Для виконання лабораторних робіт рекомендується 

використовувати безкоштовну систему призначення завдань Redmine 

та систему керування проектами ProjectLibre або LibrePlan. Крім того 

студент за власним бажанням може використовувати будь-яку 

систему керування проектами, що підтримує необхідні можливості. 

Загальний залік з практичної частини курсу студент одержує 

після виконання і здачі всіх лабораторних робіт. 
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Лабораторна робота № 1 

Робота з системою управління завданнями Redmine 

1.1 Мета роботи 

Одержання практичних навичок роботи з системою управління 

завданнями з інтеграцією з системою керування версіями коду. 

1.2 Основні теоретичні відомості 

Redmine [1] – це відкритий серверний веб-застосунок для 

управління проектами та завданнями (в тому числі для відстеження 

помилок). Redmine написаний на Ruby на основі веб-фреймворку 

Ruby on Rails. 

Даний продукт надає наступні можливості: 

– ведення декількох проектів; 

– гнучка система доступу, заснована на ролях; 

– система призначення та відстеження завдань; 

– діаграми Гантта і календар; 

– ведення новин проекту, документів і управління файлами; 

– оповіщення про зміни за допомогою RSS-потоків і 

електронної пошти; 

– вікі та форуми для кожного проекту; 

– облік часових витрат; 

– інтеграція з системами контролю версій коду; 

– створення записів про помилки на основі отриманих листів. 

Redmine створює окремий простір для кожного проекту. Це 

простір описує стан проекту (призначені завдання, учасники проекту, 

останні новини та ін.) і надає доступ до засобів управління проектом. 

Redmine використовує термін issue (проблема, питання) для 

позначення завдання розробки. 

Існує кілька стандартних категорій для завдань (трекерів): 

– Feature – нова функція; 

– Bug – помилка, невірна робота існуючого коду; 

– Support – підтримка. 

Адміністратор системи може додати нові категорії завдань під 

конкретний проект. 

Користувачам системи призначаються ролі, які визначають, що 

кожен користувач може зробити в рамках кожного проекту. 
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Наведемо стандартні ролі системи в порядку убування їх 

привілеїв: 

– адміністратор сайту управляє сайтом і обліковими записами 

користувачів, налаштовує дозволи для ролей тощо; 

– менеджер проекту може створювати нові проекти, управляти 

простором проекту (наприклад, управляти учасниками проекту і 

їхніми ролями), управляти документами проекту, новинами, вікі і 

форумом; 

– розробник управляє і редагує завдання, виконує фіксацію 

змін в репозиторій, редагує вікі, управляє файлами проекту, змінює 

репозиторій; 

– генератор звітів створює і переглядає завдання, протоколює 

час витрачений на завдання, переглядає репозиторій, переглядає вікі, 

бере участь в обговореннях на форумі. 

Тільки адміністратор системи має доступ до глобальних 

налаштувань системи, в тому числі до активації модулів системи, 

таких як наприклад, репозиторії та їх налаштування. 

Користувачам призначається роль в кожному проекті, в якому 

він бере участь, наприклад, «менеджер в проекті А», «розробник в 

проекті Б» або «клієнт в проекті В». Користувач може мати кілька 

ролей. Призначення ролі для окремого завдання в даний момент 

неможливо. 

Потік робіт (workflow) – це зміна статусів завдань в системі, це 

те як Redmine відстежує завдання від створення до закінчення 

виконання. За замовчуванням послідовність дій над завданням 

включає наступні статуси (рис. 1.1): 

– New - нова; 

– In Progress – в роботі; 

– Feedback – зворотний зв'язок; 

– Resolved – вирішена; 

– Closed – закрита; 

– Rejected – відхилена. 

За замовчуванням, будь-хто, хто увійшов в систему, може 

створити завдання, але тільки Менеджер може видалити, відхилити 

або відкрити заново закрите завдання. 

1.2.1 Проект 

Список проектів (з можливістю додати новий) доступний з 
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верхньої панелі меню (пункт Projects).  

За замовчуванням, створювати проекти в системі можуть тільки 

адміністратори і менеджери проектів.  

 
Рисунок 1.1 – Стандартний потік робіт системи Redmine 

При створенні проекту (рис. 1.2) необхідно вказати ім'я та 

унікальний ідентифікатор, який буде використаний як частина адреси 

url простору проекту, опис та домашню сторінку проекту.  

 
Рисунок 1.2 – Створення проекту 
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Проект може бути створений у вигляді підпроекту вже 

існуючого проекту.  

Після створення в налаштуваннях проекту необхідно вказати 

виконавців проекту (рис. 1.3). Хоча б один користувач повинен бути 

призначений в якості менеджера проекту. 

 
Рисунок 1.3 – Додання виконавців створеного проекту 

Простір обраного проекту (рис. 5.3) відображає його назву у 

верхній частині і містить панель вкладок, яка надає доступ до 

наступних пунктів для управління проектом і його підтримки: 

– Overview – огляд проекту (відстеження завдань, учасники 

проекту, останні новини, витрачений час); 

– Activity – останні активності в проекті; 

– Issues – завдання проекту; 

– Gantt – діаграма Гантта проекту; 

– Calender – календар; 

– News – новини, анонсовані менеджером проекту, або 

важлива загальна інформація про статус проекту; 

– Documents – робочі документи (документація, специфікації, 

замітки, інструкції); 

– Wiki – вікі для опису проекту, підтримує історію; 

– Files – файли, що використовуються в розробці (наприклад, 

для скачування членами проекту або файли проекту в вигляді релізу); 

– Forums – форум для обговорення проекту його учасниками; 

– Settings – налаштування. 

1.2.2 Завдання 

Завдання є центральним поняттям всієї системи, що описує 

якусь роботу, яку необхідно виконати, або проблему, яку необхідно 

вирішити. 
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Завдання прив'язане до певного проекту, належить певному 

користувачеві, може бути пов'язана з певною версією тощо. 

Створюване завдання призначається на одного з членів 

проектної команди. Робота, що проводиться над завданням, можуть 

відстежувати члени команди, яких додано в спостерігачі.  

При створенні завдання (рис. 1.4) вказується наступна 

інформація: 

– Tracker – категорія завдання; 

– Subject – короткий опис завдання; 

– Description – детальний опис завдання; 

– Status – стан завдання (зазвичай нове завдання має статус new 

і по мірі виконання роботи над завданням статус буде змінюватися); 

– Priority – пріоритет завдання (low, normal, high, urgent, 

immediate); 

– Assignee – учасник проекту, на якого призначається завдання; 

– Start date и due date – планові дати початку і завершення 

завдання ; 

– Estimated time – оцінка часу виконання; 

– Files – файли з відомостями щодо завдання, наприклад, 

скріншоти екрану; 

– Watchers – учасники проекту, які будуть отримувати 

оповіщення про зміну статусу завдання. 

Існуючі задачі відображаються списком на вкладці Issues.  

Коротке зведення (summary) відображає статистику про 

завдання в різних блоках по: трекерам, пріоритетам, користувачам, на 

яких призначені завдання, авторам, версіями, категоріям. Кожен з 

блоків може бути обраний для більш деталізованого перегляду. В 

цьому випадку будуть відображені не тільки завдання в станах 

закрито / відкрито / всього, але і по всім іншим налаштованим 

статусам завдань. 

На сторінці перегляду завдання (рис.1.5) відображається 

поточний стан роботи, відомості про те, що вже зроблено в процесі 

виконання завдання в хронологічному порядку, а також надаються 

інструменти для управління завданням. 
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Рисунок 1.4 – Створення завдання 

 

 
Рисунок 1.5 – Сторінка перегляду завдання 

Завдання може бути розбито на підлеглі завдання (subtasks), що 

дозволяє регулювати відношення батько-нащадок між завданнями.  
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Для батьківського завдання дата початку – найраніша з дат 

початку підлеглих задач, дата завершення – найпізніша з дат 

завершення підлеглих задач, пріоритет – найвищий з пріоритетів 

підлеглих задач, оцінка часу виконання – сума оцінок часу підлеглих 

задач, витрачений час – сума часу витраченого на підлеглих задач, 

відсоток виконання – зважене середнє значення відсотка виконання 

підлеглих задач.  

Для завдання можна додати пов'язані з ним завдання (Related 

issues).  

Зв'язування завдань дозволяє розробникам позбутися 

дубльованих завдань шляхом їх об'єднання один з одним, або 

позначити послідовність вирішення завдань.  

При зв'язуванні завдань можна встановити різні варіанти 

відносин: 

– related to / пов'язане з – просто додає посилання на інше 

завдання; 

– duplicates / дублює – пов'язує завдання так, щоб при закритті 

завдання оригіналу буде закрито і завдання дублікат: 

o наприклад, якщо завдання B дублює A, закриття B 

залишить A відкритою, а закриття A автоматично закриє 

B; 

– duplicated by / дублюється – зворотній зв’язок дублювання; 

– blocks / блокує – пов'язує завдання так, що закриття 

блокованого завдання неможливо, поки не буде закрито завдання-

блокіратор: 

o наприклад, якщо завдання B блокує завдання A, A не 

може бути закрита, поки не закрито B; 

– blocked by/ блокується – зворотнє від блокує; 

– precedes / передує  – пов'язує завдання, визначаючи такий 

порядок їх виконання, де завдання A повинне бути завершене за x днів 

до того як завдання B повинна бути запущене:  

o наприклад, якщо завдання A передує завданню B, ви не 

зможете встановити дату початку задачі B такою, що 

дорівнює або менше дати закінчення завдання A; 

– follows / іде слідом  – зворотнє від передує. 

o наприклад, якщо завдання B слідує за завданням A 

(наприклад A закінчується 21.04, а B починається 22.04) і ви 

встановлюєте +2 дня до закінчення завдання А, то дати початку і 
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закінчення завдання B зрушити на +2 дня теж ; 

– copied from / скопійовано з – пов'язує завдання, отримані 

шляхом копіювання; 

– copied to — скопійовано в. 

Над завданням можна проводити наступні дії: 

– Edit – додання опису прогресу по завданню, відсотка 

виконання, зміна статусу завдання ; 

– Log time – учасник проекту може протоколювати час, 

витрачений на завдання; 

– Watch – учасник проекту може стати спостерігачем завдання. 

При натисканні на посилання Edit відображається вікно для 

редагування відомостей про завдання (рис. 1.6), в якому можна 

змінити статус, змінити виконавця, відсоток виконання, додати 

замітки про роботу, файли тощо. 

 
Рисунок 1.6 – Редагування завдання 

1.2.3 Персональна сторінка користувача 

Персональна сторінка користувача (My page) дозволяє 

відобразити різні блоки, які містять інформацію про проекти, в яких 

він залучений. За замовчуванням активовані два блоки (рис.1.7):  

– Issues assigned to me  – призначені для виконання завдання ; 
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– Reported activities – відомості про завдання, на які користувач 

призначений спостерігачем. 

 
Рисунок 1.7 – Персональна сторінка користувача 

1.2.4 Відстеження прогресу 

Для відстеження прогресу за завданнями використовуються 

кілька засобів: 

– Calendar – в календарі зазначаються початкова та кінцева 

дати завдань (рис. 1.8); 

– Gantt chart – на діаграмі Гантта відображаються початкові і 

кінцеві дати завдань, їх статуси, зв’язки і відсоток виконання (рис.1.9). 

 
Рисунок 1.8 – Календар проекту 
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Рисунок 1.9 – Діаграма Гантта 

1.2.5 Відстеження часу 

Відстеження часу (Log time) дозволяє користувачам вказати, 

скільки годин роботи витрачено на певне завдання проекту. Кожен 

запис витраченого часу (рис. 1.10) може бути рознесений за типом 

діяльності (проектування або розробка) і доповнений коментарями.  

Слід зауважити, що витрачений час фіксується в десятковому 

форматі! 

 
Рисунок 1.10 – Протоколювання витраченого часу 

Ці дані можуть бути використані, наприклад, для аналізу внеску 

кожного учасника в проект або для оцінки фактичної трудомісткості і 

вартості розробки. 

Після створення набору записів про витрачений час сторінка 

Подробиці трудовитрат (spent time) (рис.1.11) відобразить витрачений 

час на проект (вкладка owerview -> бічна панель spent time -> details). 
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Рисунок 1.11 – Відстеження часу, витраченого на завдання 

1.2.6 Оперативний план (Roadmap) 

Оперативний план забезпечує засноване на версіях 

відображення завдань, що гнучко настроюється і допомагає планувати 

і управляти розробкою проекту. Він забезпечує згрупований 

(заснований на версіях) огляд поточного стану проекту.  

Пункт меню оперативного плану відображається в меню 

проекту тільки якщо в проекті включений модуль завдань і через 

настройки проекту створена хоча б одна версія (рис. 1.12). 

 
Рисунок 1.12 – Створення версії програмного продукту 

Вкладка "Оперативний план" (Roadmap) надає огляд поточного 

стану вашого проекту, який містить наступні "блоки" інформації для 

всіх (не завершених) версій (рис. 1.13): 

– імя версії; 

– дата, на яку заплановано завершення версії; 

– прогрес бар, що показує загальний відсоток 
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активних/завершених/закритих завдань на основі відсотка готовності, 

очікуваний час і  статуси завдань, що прив’язані до відповідної версії; 

– вміст вікі сторінки, що прив’язано до версії; 

– список прив'язаних до версії завдань. 

Якщо натиснути на назву версії, відобразиться детальне подання 

поточного стану конкретної версії (рис. 1.14). 

 

 
Рисунок 1.13 – Оперативний план проекту 

 

 
Рисунок 1.14 – Детальний опис версії продукту 
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1.2.7 Інтеграція з системами контролю версій 

Redmine може бути інтегрований з системами контролю версій: 

Subversion, Darcs, Mercurial, CVS, GIT. 

Ці системи можуть бути використані в якості сховищ коду і для 

відстеження змін в коді. 

Для роботи з репозиторіями відповідні пакети (SVN, GIT тощо) 

повинні бути встановлені на тій же машині, що і Redmine. Для 

Subversion репозиторію підтримуються всі стандартні протоколи 

(http:, svn:, file: ...), тобто можна просто вказати URL існуючого 

віддаленого репозиторію. Включити підтримку репозиторієв може 

тільки адміністратор системи (рис. 1.15). 

 
Рисунок 1.15 – Налаштування систем контролю версій коду 

адміністратором системи 

Інтеграція полягає у відстеженні змін у зовнішньому 

репозиторії, їх фіксації в базі даних, аналізі коментарів до змін з 

метою їх прив'язки до певних завдань. 

Спочатку необхідно створити новий репозиторій (рис. 1.16). 
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Рисунок 1.16 – Підключення репозиторію 

Для сховища необхідно встановити відповідність користувачів 

сховища та системи Redmine (рис. 1.17). 

 
Рисунок 1.17 – Налаштування користувачів репозиторію 

Вкладка Сховище (Repository) використовується для огляду 

сховища проекту і дозволяє переглядати останні фіксації (рис. 1.18). 

 
Рисунок 1.18 – Інтеграція з репозиторієм 

При отриманні даних зі сховищ коментарі до коммітов 

проглядаються на наявність ключових слів, що позначають завдання 
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проекту. Це дозволяє автоматично додавати в систему відомості про 

стан завдань. 

Ключові слова за замовчуванням (регистронезалежні): 

– для прив’язування до завдання: refs, references, IssueID; 

– для завершення завдання: fixes, closes. 

В системі за замовчуванням не встановлено статус, який 

застосовується для автозавершення завдання, тому його необхідно 

задати. Зробити це може лише адміністратор системи (рис. 1.15). 

Приклад коментаря: 

This commit refs #1, #2 and fixes #3 

Після ключового слова ідентифікатори завдань повинні бути 

розділені пробілом, комою чи символом &. 

Якщо встановлений прапорець "включити відстеження часу" 

(Настройки -> Репозиторії), розробники можуть відображати час, 

витрачений на завдання через повідомлення, які супроводжують 

комміт. В такому випадку необхідно вказати номер завдання і 

ключову комбінацію @ <time>, яка містить години і хвилини 

виконання. 

Наприклад: refs #1234 @15m 

Пов'язані редакції (Associated revisions) будуть відображені на 

сторінці завдання (в основному праворуч від першої відповіді). 

1.3 Завдання на лабораторну роботу 

1.3.1 Створіть репозиторій в системі Github. 

1.3.2 Створіть хоча б 2 користувача в системі Redmine, один з 

яких буде менеджером проекту, а інший – розробником. 

1.3.3 Створіть проект та декілька завдань в ньому. Призначте 

завдання на виконавців, додайте спостерігача. 

1.3.4 Створіть версію продукту та додайте до нього завдання. 

1.3.5 Підключіть репозиторій до проекту та укажіть 

відповідність користувачів двох систем. 

1.3.6 Продемонструйте потік робіт в системі. Іншими словами, 

змініть статуси завдань, наприклад, наступним чином: нова -> в 

процесі -> зворотній зв'язок -> закрита. 

1.3.7 Додайте записи про витрачений на завдання час. 

1.3.8 Змініть статуси завдань за допомогою фіксацій в 

репозиторії.  



20 

1.3.9 Додайте відомості про витрачений час за допомогою 

фіксації змін в репозиторії. 

1.3.10 Підготуйте звіт з лабораторної роботи. 

 

1.4 Контрольні питання 

1.4.1 Для чого необхідні системи управління завданнями? 

1.4.2 Що таке трекер і яких типів вони бувають? 

1.4.3 Що таке потік робіт? 

1.4.4 Поясніть основні принципи роботи з системою 

призначення завдань. 

1.4.5 В чому полягають можливості інтеграції системи 

призначення завдань і системи контролю версій коду? 
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Лабораторна робота № 2 

Створення проекту та календарне планування робіт 

2.1 Мета роботи 

Одержання практичних навичок створення проекту і планування 

робіт із застосуванням програмного забезпечення по керуванню 

проектами. 

2.2 Основні теоретичні відомості 

ProjectLibre 2.5 [2] – це програмний пакет загального 

призначення для керування проектами. ProjectLibre дозволяє швидко 

спланувати проект, наочно представити його структуру, виявити 

"вузькі місця", випробувати різні сценарії й варіанти, одержати набір 

проектної документації, що відповідає загальноприйнятим світовим 

стандартам. При цьому ProjectLibre охоплює як управлінські функції 

(«хто, коли й що повинен робити»), так і вартісні характеристики 

проекту. 

На рис. 2.1 наведена екранна форма, яка ілюструє основні 

елементи інтерфейсу системи ProjectLibre. 

 
Рисунок 2.1 – Інтерфейс системи 
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2.2.1 Створення нового проекту 

Для створення нового проекту скористайтеся меню [File » New] 

(рис.2.2). 

 
Рисунок 2.2 – Вікно створення нового проекту 

У діалоговому вікні, що відкрилося, додайте наступні дані: 

– назву проекту, 

– менеджера (ПІБ студента), 

– дату початку (або дату закінчення) проекту, 

– тип розкладу (при плануванні вперед потрібно вказати дату 

початку, а при плануванні назад – дату закінчення проекту). 

Більш детальну інформацію про проект можна додати за 

допомогою меню [File » Project » Information] (рис. 2.3). 

 
Рисунок 2.3 – Вікно інформації про проект 
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У цьому ж діалоговому вікні на вкладці Статистика можна 

ознайомитися з поточною статистикою по відкритому проекту: 

вартість та тривалість проекту, поточний відсоток виконання тощо. 

2.2.2 Календар проекту 

Календар (Calendar) – це інструмент формування розкладу 

проекту, що дозволяє встановлювати розподіл робочого й неробочого 

часу завдань і ресурсів. 

За допомогою меню [File » Project » Calendar] можна 

налаштувати робочі календарі для проекту (рис.2.4-2.5): задати час 

початку роботи, кількість робочих годин на день, тиждень та місяць, а 

також розклад змін при змінній роботі. 

 
Рисунок 2.4 – Робочий календар проекту 

ProjectLibre надає три усталених календарі: стандартний 

календар (п'ятиденка), 24-годинний календар і календар з нічними 

змінами. Зазвичай в якості базового використовується стандартний 

календар. 
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Рисунок 2.5 – Налаштування тривалості робочого часу 

2.2.1 Види 

Види дозволяють розглядати проект із різних точок зору. В 

ProjectLibre існує дві основні категорії видів (вкладка [View] або 

пункти меню [Task] і [Resource]): 

– вид завдань; 

– вид ресурсів. 

В одному й тому самому вікні ProjectLibre можна виводити 

комбінації видів за допомогою пунктів у меню [View » Sub-views]. 

Усталеним видом проекту є Подання Гантта (рис.2.1).  

2.2.2 Завдання проекту 

Планування завдань проекту тією чи іншою мірою здійснюється 

в період усього строку виконання проекту. На самому початку 

життєвого циклу проекту зазвичай розробляється неофіційний 

попередній план – грубе уявлення про те, що буде необхідно виконати 

у випадку реалізації проекту.  

Рішення про вибір проекту значною мірою ґрунтується на 

оцінках попереднього плану. Формальне й детальне планування 

проекту починається після ухвалення рішення про його реалізацію. 

Визначаються ключові точки проекту, завдання і їх взаємозалежність. 

Середовище ProjectLibre включає набір засобів для розробки 

плану проекту: таблицю для введення завдань і діаграму Гантта [Task 

» Views » Gantt], графічне подання ієрархічної структури робіт [Task » 

Views» WBS], мережний графік [Task » Views» Network]. 

Діаграма Гантта – це графічне подання всіх завдань, які 

складають проект. Діаграма Гантта складається зі смуг, орієнтованих 

уздовж осі часу. Кожна смуга представляє окреме завдання (роботу) 

проекту, її кінці – моменти початку і завершення роботи, її довжина – 

тривалість роботи. Крім того на діаграмі можуть бути відзначені 
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сукупні завдання, відсотки завершення, покажчики залежності робіт, 

віхи проекту, мітка теперішнього моменту часу тощо. 

Завдання (Task) у плані проекту передбачає якусь діяльність, 

яка необхідна для досягнення конкретних результатів (кінцевих 

продуктів нижнього рівня, deliverables). На виконання завдань 

необхідний час. Момент завершення завдання означає факт одержання 

кінцевого продукту, тобто результату виконання завдань. 

Виділяють три основні типи завдань. 

Зведені або складені завдання (Summary task), що містять 

декілька підлеглих завдань. 

Підлеглі завдання (Subtask) – невеликі завдання, що є 

частиною якихось більших завдань. 

Віхи (Milestone) – це завдання, у яких встановлена нульова 

тривалість і які позначають проміжні цілі проекту. Віха – ця подія або 

дата в ході виконання проекту. Вона використовується для 

відображення стану завершеності тих або інших завдань. У контексті 

проекту менеджери використовують віхи для того, щоб позначити 

важливі проміжні результати, які повинні бути досягнуті в процесі 

реалізації проекту. Послідовність віх проекту називається планом по 

віхах. Важливою відмінністю віхи від завдання є те, що вона не має 

тривалості.  

Організація завдань проекту включає наступні дії. 

Визначення завдань – розбивка очікуваних результатів проекту 

на більш дрібні завдання, які легше піддаються обліку й керуванню. 

Визначення послідовності завдань – установлення залежності 

між завданнями й визначення обмежень у властивостях завдань. 

Оцінка тривалості завдань і проекту в цілому – оцінка часу, 

необхідного для завершення всіх завдань проекту. 

Для організації завдань проекту в середовищі ProjectLibre 

необхідно перейти у подання Гантта. 

Перший крок – створення начерку робіт (зведених завдань), які 

необхідно виконати в проекті. 

Для створення завдання в таблиці завдань виберіть комірку 

Name і вкажіть назву завдання. Встановіть тривалість завдання або 

оцінку тривалості завдання (позначається знаком питання). 

При подвійному клацанні мишею на завданні або виборі меню 

[Task » Information] відкриється діалогове вікно Інформація про 

завдання (рис. 2.6). Тут можна додати більш докладний опис завдання, 
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а також указати коментарі та посилання на відповідні документи. 

Для створення віхи, укажіть назву й встановіть тривалість 

завдання в значення 0. Віхи в ProjectLibre на діаграмі Гантта 

представлені у вигляді ромбів, а не смужок. 

Перелік стовпців таблиці Завдання можна змінювати за 

необхідності, натиснувши праву кнопку мишки на заголовку й 

вибравши в контекстному меню пункт Вставити стовпець або 

Сховати стовпець. 

 
Рисунок 2.6 – Вікно інформації про завдання 

Для того щоб розділити завдання на частині (Split task) так, 

щоб її частини можна було виконувати в різний час, або якщо буде 

потреба перервати завдання на час (відпустка або хвороба виконавця), 

натисніть праву кнопку миші на завданні в діаграмі Гантта й у 

спливаючому контекстному меню виберіть пункт [Split] (рис.2.7). 

 
Рисунок 2.7 – Поділ завдання 

За замовчуванням в ProjectLibre використовується шкала тижнів 
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і днів для відображення діаграми Гантта. Якщо необхідно побачити 

укрупнену картину проекту, ви можете перемкнутися на шкалу 

місяців, років й кварталів і так далі. Для цього скористайтеся 

кнопками зміни масштабу виводу [Zoom In] і [Zoom Out] у режимі 

перегляду завдань. 

2.2.3 Структурування завдань 

Для структурної декомпозиції завдань проекту після внесення 

зведених завдань у таблицю необхідно додати підлеглі завдання й 

включити їх у зведені (рис. 2.1).  

Інструмент структурування доступний у вигляді пунктів меню 

Відступ і Виступ або відповідно [Task » Indent] і [Task » Outdent]. 

Зведене завдання вирівняне вліво, його назва виділена жирним 

шрифтом, і перед назвою розміщається кнопка [-], що означає 

Згорнути. Відповідні підлеглі завдання розташовані з відступом 

вправо щодо зведеного завдання. 

Зверніть увагу, що будь-яка дія над зведеним завданням – 

видалення, переміщення або копіювання – застосовується також до 

всіх вкладених завдань. 

2.2.4 Зв'язки між завданнями, затримки й перекриття 

зв'язків 

Зв'язки передування (логічні залежності, Link) між завданнями 

відображають природу залежностей між ними. Більшість залежностей 

у проектах відносяться до типу «Закінчення-Початок», при якому 

наступне завдання може бути виконане тільки після завершення 

попереднього завдання.  

Зв'язки передування утворюють мережну структуру проекту. 

Сукупність взаємозв'язків між завданнями також називаються 

логічною структурою проекту, яка визначає послідовність виконання 

завдань. 

Для переходу до календарного планування необхідно визначити 

зв'язки передування між завданнями проекту. Дати початку або 

завершення кожного завдання у середовищі ProjectLibre не 

встановлюються вручну, а визначаються автоматично після 

встановлення зв'язків між завданнями.  

Завдання, яке впливає на інше завдання, називається 

Попередником (Predecessor), а завдання, яке залежить від іншого 
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завдання, називається Послідовником (Successor). Наприклад, 

завдання «Програмування» є попередником для завдання 

«Тестування». 

Завдання можуть бути зв'язані чотирма типами зв'язків, 

наведеними в таблиці 2.1. 
 

Таблиця 2.1 – Типи зв'язків між завданнями 

Зв'язок Тип Опис 
Подання на 

діаграмі Гантта 

Закінчення-

Початок 

(Finish-Start) 
FS 

Завдання В почнеться 

відразу чи через N днів після 

завершення задачі А. Якщо 

завдання А прострочене, то 

старт завдання В 

відкладається до тих пір, 

поки завдання А не буде 

закрито 

 

Початок-

Початок (Start-

Start) 
SS 

Завдання В почнеться 

відразу чи через N днів після 

старту задачі А. Якщо дата 

старту задачі А зміниться, то 

і старт задачі В зміститься 

відповідно 

 

Закінчення-

Закінчення 

(Finish-Finish) 
FF 

Завдання А повинно 

завершитися перед тим, як 

завдання В зможе 

завершитися 
 

Початок-

Закінчення 

(Start-Finish) 
SF 

Завдання А повинно 

початися перед тим, як 

завдання В зможе 

завершитися 

(рідко використовується) 

 

 

Іноді буває необхідно вказати запізнювання або випередження 

(Lag and Lead, затримка) в зв'язку між завданнями. Затримки можуть 

бути зазначені в одиницях часу або у відсотках від тривалості 

завдання-попередника. При цьому позитивна затримка означатиме 

запізнювання, а негативна – випередження. 
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Приміром, між завданнями «Програмування» і «Тестування» 

повинен пройти один тиждень, щоб з'явився код для тестування. У 

випадку, коли затримка задається у відсотках, якщо попереднє 

завдання триває 4 дні, затримка в 25% складатиме 1 день.  

Існує декілька способів установки й редагування зв'язків в 

Projectlibre. 

Оберіть завдання, які ви прагнете зв'язати. Завдання з меншим 

номером ID буде трактуватися як попередник. Потім для установки 

зв'язку натисніть у меню [Task » Link].  

Інший спосіб – установка й редагування зв'язків за допомогою 

мишки – виконується шляхом перетаскування одного завдання на 

інше в діаграмі Гантта  

За замовчуванням ProjectLibre встановлює зв'язок типу 

Закінчення-Початок (FS). Для зміни зв'язку необхідно двічі клацнути 

по стрілці зв'язку на діаграмі Гантта, а потім у вікні Залежність 

завдань (Task Dependancy) обрати необхідний тип зв'язку й указати 

затримку (рис. 2.8). 

Для швидкої установки попередників завдання можна 

скористатися полем Predecessors таблиці завдань. У ньому через 

крапку з комою необхідно вказати ID завдань-попередників. Тип 

зв'язку встановлюється за замовчуванням FS. У тих випадках, коли 

необхідний зв'язок іншого типу, крім номера завдання необхідно 

вказати англійську абревіатуру типу зв'язку (рис. 2.9). 

 
Рисунок 2.8 – Установка типу залежності між завданнями 

 

 
Рисунок 2.9 – Попередники завдань 

Також можна редагувати зв'язки в діалоговому вікні Інформація 

про завдання, як показано на рис. 2.10. 
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Рисунок 2.10 – Установка попередників для завдання 

Щоб видалити зв'язок, виберіть два завдання й скористайтеся 

меню [Task » Unlink]. 

Не намагайтеся видалити зв'язок шляхом видалення комірки в 

стовпці попередника натисканням клавіші <Del>, тому що при цьому 

віддалиться вся завдання. 

2.2.5 Обмеження 

Деякі завдання можуть бути прив’язані до певної дати. 

Розглянемо застосування прив'язки завдань до певних дат при 

складанні плану проекту. Прив'язка завдань до дат у середовищі 

ProjectLibre виконується за допомогою параметра Обмеження 

(Constraint). Існує 8 типів обмежень (рис. 2.11). Обмеження бувають 

двох категорій – гнучке обмеження й негнучке обмеження. 

Установка обмеження проводиться в такий спосіб (рис. 2.11). 

1. Відкрийте діалогове вікно Інформація про завдання. 

2. Перейдіть на вкладку Додатково й виберіть Тип обмеження 

зі списку. 

3. Укажіть значення Дати обмеження. 

Негнучкі обмеження суттєво обмежують можливість 

планування та можуть викликати конфлікти між наступним й 

попереднім завданнями, що може викликати необхідність видалити 

такі обмеження. 
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Рисунок 2.11 – Установка обмеження для завдання 

2.2.6 Установка контрольного строку 

Встановіть дату контрольного строку (Deadline), щоб не 

ставити негнучке обмеження. Установка контрольного строку ніяк не 

впливає на розрахунок графіка проекту. Контрольний строк 

позначається на діаграмі Гантта жовтим ромбом. Якщо строк 

пройшов, а завдання не було виконане, ProjectLibre укаже це в 

першому стовпці таблиці завдань Індикатор (хрестик у червоному 

кружку, у списку завдань при виводі діаграми Гантта). 

2.2.7 Критичний шлях проекту 

Критичне завдання (Critical task) – це завадння, що не має 

резерву часу. Будь-який зсув дати завершення такого завдання на 

більш пізній строк приведе або до зсуву наступного завдання, або до 

запізнювання проекту в цілому. 

Критичний шлях (Critical path) – це послідовність 

взаємозалежних критичних завдань, що з'єднує початкову й кінцеву 

дати проекту. Іншими словами це найбільш довгий маршрут у 

мережній діаграмі проекту. Критичний шлях визначає мінімально 

можливу тривалість проекту при заданій структурі. Будь-які затримки 

на критичному шляху затримують закінчення проекту.  

В ProjectLibre на діаграмі Гантта критичні завдання 

відображаються червоним кольором, а не критичні – синім кольором. 

Для некритичних завдань також можна відобразити часовий резерв 
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(Total Slack) в контекстному меню на діаграмі Гантта. 

2.2.8 Підготовка звітів по проекту 

В ProjectLibre не так багато варіантів для формування звітів, 

якщо порівнювати з комерційними продуктами. Однак подання 

інформації у звітах проводиться з достатньою якістю. 

Дата звіту про стан (або контрольна дата, Status date) – це дата, 

на яку слід одержати інформацію про стан проекту. За замовчуванням 

датою звіту про стан вважається поточна дата. Користувач може 

вибирати контрольну дату довільно, але з однією умовою: вона 

повинна бути розташована на осі часу «лівіше» поточної дати. 

Фільтрація дозволяє в будь-який момент накладати певні 

умови на спосіб виводу інформації (у тому числі й для звітів). Ви 

можете сховати інформацію, яку ви не прагнете бачити або виділити 

важливу інформацію, змінити порядок сортування даних, об'єднати їх 

у групи (наприклад, по виконанню, критичності, по залучених 

ресурсах). Для цього використовується пункт меню [View » Filters]. 

Для формування звітів по проекту виберіть пункт меню [View» 

Other views  » Report]. 

Тип звіту – це тип або категорія звіту, що визначає, якого роду 

інформація про проект повинна бути поміщена в друкований 

документ. В ProjectLibre передбачено 4 категорії звітів: 

– загальні відомості про проект (Project details); 

– інформація про ресурси (Resource information); 

– інформація про завдання (Task information); 

– призначення (Who Does What). 

2.3 Завдання на лабораторну роботу 

2.3.1 Використовуючи рекомендовану літературу й дані 

методичні вказівки, ознайомтеся з основними принципами роботи із 

програмами для керування проектами в цілому й зокрема із системою 

ProjectLibre. 

2.3.2 Ознайомтеся із проектним завданням у додатку А. 

2.3.3 Створіть новий проект. Виберіть спосіб планування від 

дати початку проекту. Уведіть дату початку проекту, скорегувавши 

строки проектного завдання так, щоб початок проекту збігся з 

початком семестру.  
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2.3.4 Налаштуйте календар проекту, у якому святкові дні 

відзначте як неробочі.  

2.3.5 Створіть план проекту відповідно до проектного завдання: 

у таблицю завдань додайте завдання, обмеження, тривалості завдань, 

визначте логічні зв'язки між завданнями. 

2.3.6 Придумайте й додайте у проект своє невелике завдання. 

2.3.7 Додайте до плану необхідні затримки й випередження. 

2.3.8 Порівняйте отримані та установлені у завданні строки 

виконання етапів робіт. 

2.3.9 Встановіть контрольний строк завершення останньої 

завдання проекту трьома днями пізніше планового строку її 

завершення. 

2.3.10 Визначите тривалість проекту. 

2.3.11 Підготуйте наступні звіти: Загальні відомості про проект 

(Project Details), Завдання проекту (Task Information=>Default), 

Діаграма Гантта, Мережний графік, Ієрархічна структура робіт 

проекту, Критичні й некритичні завдання й часові резерви завдань 

(Task Information=>Schedule CPM). 

2.4 Контрольні питання 

2.4.1 Яке призначення систем керування проектами? 

2.4.2 Як визначається тривалість виконання проекту? 

2.4.3 Що таке критичне завдання й критичний шлях проекту? 

Що таке часовий резерв завдання? 

2.4.4 Які типи логічних залежностей між завданнями існують і 

як вони впливають на розрахунки календарного плану проекту? 

2.4.5 Як використовувати запізнювання й випередження при 

формуванні залежностей між завданнями? 

2.4.6 Для чого необхідні календарі? 

2.4.7 Що таке віхи й навіщо вони необхідні? 

2.4.8 Для чого необхідно структурувати завдання проекту? Що 

таке ієрархічна структура робіт проекту? 

2.4.9 Що таке обмеження завдань і які вони бувають? 

2.4.10 Що таке крайній строк виконання завдання і як його 

можна використовувати? 

2.4.11 Яким чином можна врахувати перерви у виконанні 

завдань? 
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Лабораторна робота № 3 

Планування ресурсів, створення призначень і 

вартісний аналіз проекту 

3.1 Мета роботи 

Вивчення особливостей планування призначень для 

співробітників і матеріальних ресурсів, а також принципів розподілу 

завантаження ресурсів під час виконання завдань, проведення 

вартісного аналізу проекту. 

3.2 Основні теоретичні відомості 

3.2.1 Ресурси проекту 

Ресурси (Resource) – це компоненти, які забезпечують 

виконання проектних робіт. Вони включають виконавців, матеріали, 

устаткування, енергію тощо.  

Ресурси бувають двох типів – робота й матеріали. 

Ресурси типу Робота (Work) виконують завдання шляхом 

витрати часу на завдання. Звичайно це люди або устаткування. 

Ресурси типу Матеріал (Material) – це запаси видаткових 

матеріалів і компонентів, які потрібні для виконання проекту. 

Доступний для виконання роботи набір ресурсів називають 

пулом ресурсів. Після визначення необхідної кількості ресурсів, 

необхідно встановити час і доступність кожного ресурсу. У випадку 

трудових ресурсів, кількість часу, яку вони можуть працювати, буде 

вимірятися в годинах, днях місяцях або роках, а кількості 

матеріальних ресурсів повинні бути зазначені в одиницях виміру. 

Доступність (Availability) – це період часу, протягом якого 

ресурс може бути використаний при виконанні конкретного завдання. 

Доступність ресурсу визначається трьома факторами: 

– календарями робочого часу проекту й даного ресурсу; 

– датами початку й завершення використання ресурсу в 

проекті; 

– сумарним обсягом призначень ресурсу на завдання проекту 

(максимальне використання). 

Створення пулу ресурсів проводиться у Виді ресурсів, який 

дозволяє керувати списком ресурсів та витратами на ресурси. 
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3.2.2 Заповнення списку ресурсів 

Уведення ресурсів проводиться через таблицю Виду ресурсів 

(рис.2.1). 

1. Для доступу до таблиці ресурсів скористайтеся меню 

[Resource » Resources] або [View » Resource views » Resources]. 

2. Виберіть комірку в колонці Назва й укажіть назву ресурсу. 

3. Укажіть тип ресурсу – Робота або Матеріал. Для 

матеріалів укажіть одиниці виміру. 

 
Рисунок 3.1 – Вид списку ресурсів 

У стовпці Максимальне використання (Maximum units) 

показане максимальне завантаження, яке можливе для ресурсу при 

виконанні будь-яких завдань у певний період часу. За замовчуванням 

використовується формат відсотків. Наприклад, якщо зазначено 100%, 

це означає, що цей ресурс буде працювати всі вісім годин у звичайний 

робочий день. Якщо зазначено 50%, то цей ресурс буде працювати по 

чотири години на день. У випадку пулу ресурсів, що складається з 5 

працівників, їх максимальна кількість одиниць буде 500%. 

Ресурси типу Матеріал не містять величини Максимальне 

використання. Одиниці таких ресурсів містять вартість споживання, 

яка може бути фіксованою або змінною. 

При клацанні в таблиці ресурсів по назві ресурсу буде виведене 

вікно, що містить інформацію про ресурс (рис.3.2).  

На вкладці General можна вказати індивідуальний календар 

ресурсу або змінити робочий час ресурсу. 

Для редагування календаря ресурсу натисніть кнопку із 

зображенням календаря праворуч від поля вибору календаря зі списку 

й внесіть необхідні зміни. 
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Рисунок 3.2 – Вікно з інформацією про ресурс 

У поле Group можна вказати професійну приналежність 

трудового ресурсу або вид матеріального ресурсу (наприклад, назву 

відділу або назву групи матеріалів). 

3.2.3 Методи нарахування 

Плануючи вартість проекту, необхідно не тільки визначити його 

бюджет, але й визначити, як цей бюджет буде витрачатися протягом 

усього проекту. Витрата бюджету залежить від порядку оплати робіт. 

Оплачувати роботу можна різними способами: може 

використовуватися передоплата, оплата за фактом завершення, а іноді, 

і пропорційна оплата в міру виконання робіт, причому звичайно в 

проекті можуть використовуватися кілька способів оплати. 

Метод нарахування витрат (Accrual method) – це метод обліку 

разових або фіксованих витрат, що входять у вартість роботи. В 

ProjectLibre передбачено три методи нарахування витрат: 

– на дату початку завдання (start); 

– на дату завершення роботи (end); 

– метод рівномірного розподілу на період виконання завдання 

(prorated). 

Слід зауважити, що порядок оплати робіт не впливає на 

загальну суму витрат по проекту. 

3.2.4 Визначення витрат на ресурси 

В ProjectLibre є два типи витрат, що визначають вартість 

ресурсів проекту: погодинна ставка (стандартна та понаднормова 

ставка) і витрати за використання. 

Таблиця норм витрат (Cost rate table) – це набір значень витрат 
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на ресурс, що включає стандартний і понаднормовий тариф оплати 

ресурсу, вартість разового використання ресурсу, а також інтервали 

часу, протягом яких діє той або інший тариф. 

Вартість ресурсу визначається у відповідних стовпцях таблиці у 

виді Ресурси або у вікні Інформації про ресурс на вкладці Costs. 

Ви можете вказати до 5 різних тарифних ставок для обраного 

ресурсу (A-E). У кожній з них ви можете вказати наступні ставки: 

– стандартна ставка; 

– ставка за переробку; 

– ставка за кожне використання ресурсу. 

Щоб додати витрати на ресурс виконайте наступне. 

1. Відкрийте діалогове вікно Інформація про ресурс і виберіть 

вкладку [Costs] (рис.3.3). 

 
Рисунок 3.3 – Вікно інформації про ресурс, вкладка «Вартість» 

2. Дата початку дії тарифу (Effetive date) може збігатися з 

датою початку проекту. Якщо це не так, укажіть дату або виберіть її з 

календаря. 

3. Укажіть стандартну ставку (Standart rate). За 

замовчуванням вказується значення в грн/година, але ви можете при 

необхідності вказати ставку в /рік, або в /місяць. 

4. Укажіть ставку за переробку (Overtime rate). Її необхідно 

вказувати, навіть якщо вона дорівнює стандартній ставці. 

5. Укажіть додаткову ставку за використання ресурсу 

(вартість доставки й таке інше), яка не залежить від того, скільки часу 

задіяний ресурс у завдання. 
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6. Якщо ви знаєте, що ставки можуть мінятися під час 

виконання проекту, клацніть на другому рядку, укажіть ефективну 

дату дії й внесіть нові стандартну ставку, ставку за переробку й ставку 

за використання. Ви можете вказати або абсолютні величини, або 

збільшення або зменшення в % від ставок, перерахованих у першому 

рядку. 

7. Укажіть метод нарахування шляхом вибору зі списку, що 

випадає [Accrue at]. 

При створенні призначення дані про ставку ресурсу за 

замовчуванням беруться з таблиці A норм витрат. Змінити вартість 

призначення можна, указавши іншу таблицю норм витрат для 

потрібного ресурсу. Таблиця норм витрат вказується у вікні 

інформації про завдання на вкладці Resourses колонка Cost Rate Table. 

3.2.5 Призначення ресурсів на завдання 

Наступний крок після визначення ресурсів – призначення 

ресурсів на завдання.  

Призначення (Assignment) – це елемент розкладу проекту, що 

відбиває взаємозв'язок між завданням і ресурсом, призначеним для її 

виконання. Змістовна інтерпретація цього терміну залежить від «кута 

зору»: з погляду розподілу ресурсів – це величина працезатрат 

ресурсу для виконання конкретної завдання; з погляду параметрів 

завдання – це її трудомісткість (обсяг робіт), що доводиться на даний 

ресурс. 

Для того щоб призначити ресурс на завдання, необхідно 

виконати наступні дії. 

1. На діаграмі Гантта виберіть завдання, на яке потрібно 

призначити ресурс, і виберіть меню [Task » Assign Resources]. 

Або. 

1. Відкрийте вікно інформації про завдання. Перейдіть на 

вкладку Resources і натисніть кнопку [Assign Resources]. 

2. У вікні, що відкрилося (рис. 3.3) виберіть ресурс, який ви 

прагнете призначити на завдання. 

3. Для робочих ресурсів укажіть відсоток участі в стовпці 

Units. Одиниці (обсяг призначень, units) для робочих ресурсів – це 

кількість виконавців (або часток ресурсу), призначених на завдання. 

4. При призначенні матеріальних ресурсів можна вказати як 

фіксований обсяг виділюваних на завдання ресурсів (наприклад, 2 
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коробки), так і змінний обсяг (наприклад, 1 коробка в день). Для 

матеріальних ресурсів виберіть поле Одиниці, натисніть <F2> і 

вкажіть кількість призначуваних одиниць або дані у форматі: число 

одиниць/позначення тривалості (3/d або 3/д для позначення витрати 

трьох одиниць матеріалу в день). Якщо ви залишите поле порожнім, 

буде встановлене значення за замовчуванням 1. ProjectLibre додасть 

одиниці виміру до зазначеного вами десяткового значення. 

 
Рисунок 3.3 – Призначення ресурсів на завдання 

5. Натисніть кнопку [Assign] для підтвердження. 

Щоб вилучити призначення з завдання, виберіть завдання, потім 

назву ресурсу, який потрібно вилучити, і натисніть клавішу <Del>. 

Після призначення ресурсів на завдання ProjectLibre визначає 

працезатрати кожного з ресурсів для виконання цього завдання й 

планує розподіл цих працезатрат на кожний із днів протягом усієї 

тривалості завдання. 

В ProjectLibre тривалість (duration) відповідає часу, через який 

буде отриманий результат завдання або іншими словами кількість 

часу між початком і закінченням завдання, а працезатрати або 

робота (work) відповідають часу, витраченому відповідальним 

виконавцем для одержання результату. 

При призначенні ресурсів на завдання ProjectLibre перемножує 

тривалість завдання (D) на зазначені відсотки або одиниці виміру 

ресурсів (U) для визначення робочих годин (W), які будуть витрачені 
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на завдання (D*U=W). 

При першому призначенні ресурсів на завдання, працезатрати 

обчислюються і фіксуються. 

Наприклад, для розробки деякого модуля програми встановлена 

тривалість в 5 днів і призначено 3 ресурси із завантаженням 100%. 

Припускаючи, що в дні за замовчуванням 8 робочих годин, кожний із 

цих ресурсів повинен буде працювати по 8 годин усі 5 днів. Повні 

працезатрати на завдання становлять 120 людино-годин. 

При повторному призначенні ресурсів на завдання буде 

проведений перерахунок тривалості й роботи залежно від Типу 

завдання. 

3.2.6 Типи завдань 

ProjectLibre визначає три типи завдань (Task type), які 

дозволяють перерахувати значення змінних, коли на завдання 

робиться нове призначення ресурсів: 

– фіксовані одиниці / фіксований обсяг ресурсів (Fixed Units); 

– фіксовані працезатрати (Fixed Work); 

– фіксована тривалість (Fixed Duration). 

Тип завдання визначає, як редагування однієї із властивостей 

завдання – тривалості, працезатрат або призначень – буде впливати на 

дві інші властивості. Обраний тип завдання визначає, значення якої із 

властивостей буде зафіксовано. Тривалість – це змінна завдання, а 

кількість одиниць і працезатрати – це змінні призначення. 

Розглянемо кожний з типів завдань. 

Тип завдання Fixed Duration означає, що зміна працезатрат або 

числа призначених на виконання завдань співробітників не змінить її 

тривалість  

Тип Fixed Work (Фіксовані працезатрати) установлюється для 

завдань, виконання яких вимагає строго певних працезатрат. Чим 

більше співробітників призначено на завдання, тем менший обсяг 

роботи припадає на кожного з них і тем швидше завдання буде 

виконане.  

Тип Fixed Units (Фіксований обсяг ресурсів) використовується в 

плані проекту для завдань, тривалість і обсяг роботи для яких 

повністю залежать від виділених на них ресурсів. Тривалість завдань 

із фіксованим обсягом ресурсів дорівнює працезатратам діленим на 

число призначених ресурсів. 
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У випадку якщо завдання не відноситься до типу Фіксовані 

працезатрати, додатково до позначення типу завдання можна 

використовувати прапорець Фіксованого обсягу робіт (effort-driven). 

Якщо включити дану ознаку, то працезатрати будуть зафіксовані 

одночасно з однією із двох інших ознак завдання: тривалістю або 

обсягом ресурсів. 

Керівник проекту повинен проаналізувати кожне завдання 

проекту і вибрати для нього відповідний тип. 

Нехай існує завдання тривалістю 5 днів. На нього призначено 

один трудовий ресурс обсягом 100%. Таким чином, працезатрати на 

завдання становлять 40 год. 

Розглянемо приклад в таблиці 3.1, як тип завдання впливає на 

зміни.  

 

Таблиця 3.1 – Приклад завдань трьох типів 

Тип завдання Варіант змін Результат 

фіксована 

тривалість 

Тривалість – 10 днів Працезатрати – 80 годин 

Працезатрати – 48 годин Обсяг призначення 

ресурсу – 120% 

Обсяг призначення 

ресурсу – 50% 

Працезатрати – 20 годин 

Додаємо аналогічний 

ресурс 

Працезатрати – 80 годин 

фіксовані 

працезатрати 

Тривалість – 10 днів Обсяг призначення 

ресурсу – 50% 

Працезатрати – 48 годин Тривалість – 6 днів 

Обсяг призначення 

ресурсу – 50% 

Тривалість – 10 днів 

Додаємо аналогічний 

ресурс 

Тривалість – 2,5 дня 

фіксований 

обсяг ресурсів 

Тривалість – 10 днів Працезатрати – 80 годин 

Працезатрати – 48 годин Тривалість – 6 днів 

Обсяг призначення 

ресурсу – 50% 

Тривалість – 10 днів 

Додаємо аналогічний 

ресурс 

Працезатрати – 80 годин 
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За замовчуванням в ProjectLibre тип завдання встановлений в 

значення «фіксований обсяг ресурсів» (Fixed Units) і відзначений 

прапорець «фіксований обсяг робіт». Тривалість завдання при цьому 

залежить лише від кількості призначених на неї ресурсів. Якщо ви 

зміните кількість ресурсів після початкового призначення, ProjectLibre 

змінить тривалість, але залишить вихідний обсяг робіт. 

Щоб змінити тип завдання необхідно виконати наступне: 

відкрийте вікно інформації про завдання, виберіть вкладку Advanced і 

в списку вибору Type виберіть необхідний тип завдання (рис. 3.4). 

Ви можете вивести інформацію про призначення ресурсів на 

завдання за допомогою пункту меню [Views » Task Usage].  

 
Рисунок 3.4 – Зміна типу завдання 

3.2.7 Визначення вартості проекту 

Наступний етап – це формування витрат проекту. Витрати 

проекту складаються з вартості використання ресурсів (як 

матеріальних, так і трудових) і фіксованих витрат на завдання. 

Фіксовані витрати на завдання (Fixed cost) – це витрати, не 

пов'язані з використанням проектних ресурсів.  

Для впровадження фіксованих витрат використовується поле 

фіксованих витрати в таблиці завдань (стовпець фіксованих витрат 

можна вставити натиснувши правою кнопкою миші на заголовках 

стовпців у таблиці й вибравши Insert Column => Fixed Cost) (рис. 3.5). 
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3.2.8 Контури 

За замовчуванням при створенні призначення працезатрати 

розподіляються рівномірно по всій тривалості завдання. 

 
Рисунок 3.5 – Додавання стовпця Фіксованих витрат 

Контур (Work Contour) або профіль завантаження в ProjectLibre 

– це форма розподілу робіт усередині призначення. Звичайно, якщо 

ресурсу призначають 100% використання в 40-годинному завданні, 

завдання буде розпочато негайно з роботою по 8 годин на день 

впродовж 5 днів. Це – плоский контур за замовчуванням, де робота 

кожного ресурсу рівномірно розподіляється по всій тривалості 

завдання. 

Іноді вам може знадобитися змінити розподіл роботи над 

завданням. ProjectLibre містить 8 визначених контурів (рис.3.7). 

Розглянемо особливості кожного контуру: 

– плоский – контур за замовчуванням з рівномірним 

розподілом роботи; 

– завантаження наприкінці – пік активності виникає 

наприкінці завдання; 

– завантаження на початку – пік активності виникає на 

початку завдання; 

– подвійний пік – у завдання існують два піки активності; 

– ранній пік – пік активності на початковому етапі але з 

рампою до піка; 
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– пізній пік – пік активності наприкінці проекту, але з рампою; 

– «дзвін» – одиночний пік активності в середині проекту; 

– «черепаха» – плоске завантаження без виражених піків, з 

рампами на початку й наприкінці. 

 
Рисунок 3.7 – Вибір профілю завантаження ресурсу 

Змінити робочий контур для призначення можна у поданні 

Використання завдань (Task Usage). 

3.2.9 Базовий план проекту 

Базовий план проекту (Baseline plan) – це розклад, вартість і 

зміст проекту, які використовуються в якості еталонних при керуванні 

ходом виконання проекту. Базовий план використовується для 

виконання аналізу поточної продуктивності в порівнянні із 

затвердженим планом. 

По закінченню планування й до початку виконання зберігається 

«знімок» проекту як базового плану ([File »Project » Save Baseline]).  

Крім того в проекті може бути кілька базових планів (до 10), які 

звичайно зберігаються в найбільш важливі ключові моменти проекту. 

При збереженому базовому плані на діаграмі Гантта під кожним 

завданням відображаються тіні, що відповідають базовому розкладу. 

3.2.10 Графіки 

В ProjectLibre є можливість спостерігати за вартістю й роботою 
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проекту за допомогою графіків. 

Для того щоб переглянути графіки, необхідно наступне. 

1. Вибрати пункт меню [View » Sub-views » Charts]. 

2. У таблиці завдань вибрати необхідні завдання (чи всі 

завдання проекту). 

3. У панелі, що з'явилася знизу головного вікна, вибрати 

необхідні ресурси. 

4. Налаштувати необхідні параметри для відображення: 

вибрати перемикач робота/вартість і зі списку вибрати відображувані 

величини. 

Наприклад, розглянемо Графік витрати бюджету проекту 

(рис.3.8). 

 
Рисунок 3.8 – Графік витрати бюджету 

Точно так само можна переглядати графіки, що стосуються 

робіт проекту, що залишилися для виконання. Для цього необхідно 

змінити перемикач у положення «робота». 

3.3 Завдання на лабораторну роботу 

3.3.1 Відкрийте проект, створений у лабораторній роботі №1. 

3.3.2 Створіть список трудових ресурсів, які будуть 

використовуватися в проекті згідно із проектним завданням. 

Придумайте і додайте в проект два матеріальні ресурси.  

3.3.3 Уведіть стандартні ставки для трудових ресурсів проекту 

відповідно до проектного завдання. Понаднормові ставки встановіть в 

1,5-2 рази більше стандартних. 

3.3.4 Призначте ресурси на завдання проекту. При виконанні 

призначення використовуйте матрицю завдань і відповідальності 
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проекту (див. табл. А.5). Вмовимося, що основна відповідальність 

означає 100% призначення ресурсу на завдання, а допоміжна – від 1 

до 99% (залежить від завдання). Зверніть увагу, що тривалість 

виконання завдань за проектним завданням в даній роботі є 

фіксованою. При цьому прапорець Фіксованого обсягу робіт вмикати 

не потрібно. Встановити тип завдання необхідно до призначень 

ресурсів. 

3.3.5 Для завдання, створеного у лабораторній роботі №1 п.1.3.6, 

введіть фіксовану вартість. 

3.3.6 Визначите час участі ресурсів у проекті. 

3.3.7 Визначите вартість етапів робіт і проекту в цілому. 

3.3.8 Збережіть базовий план проекту №1. 

3.3.9 Порівняйте отриману вартість проекту із затвердженим 

бюджетом. Розбіжність із затвердженим бюджетом у даній роботі 

є можливою. 

3.3.10 Підготуйте наступні звіти: Загальні відомості про проект 

(Project Details), Використання завдань (Task Usage), Список ресурсів 

(Resource information=>Default), Використання ресурсів (Who does 

what=>Basic report), Рух коштів по проекту (Task Information=>Cost, 

Baseline), Графік витрати бюджету. 

3.3.11 Створіть копію отриманого плану проекту й проведіть 

серію експериментів для вивчення властивостей призначень: 

а) визначите персональний календар для одного ресурсу 

проекту; 

б) нехай один з виконавців не працює над проектом по 

п'ятницях в одному з місяців (наприклад, у жовтні), а інший в 

ці дні працює половину робочого дня; 

в) розподілите завантаження ресурсів під час виконання завдань 

за допомогою профілів, визначте різні профілі завантаження 

для деяких завдань; 

г) проведіть дослідження по вивченню впливу властивостей 

завдань різних типів на параметри призначення; 

д) реалізуйте перерву у виконанні однієї із завдань; 

е) внесіть зміни ставки співробітника з деякої встановленої дати 

до завершення проекту, визначте різні норми витрат для 

ресурсу, призначеного на кілька різних завдань. 

Включіть у звіт результати трьох експериментів і проаналізуйте 

отримані результати. 
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3.3.12 Підготуйте звіт за лабораторної роботи. 

3.4 Контрольні питання 

3.4.1 Що таке ресурси і яких типів вони бувають? 

3.4.2 Що таке доступність ресурсу? 

3.4.3 Для чого необхідні календарі ресурсів? 

3.4.4 Що таке призначення? 

3.4.5 Поясніть три типи завдань: фіксовані одиниці, фіксовані 

працезатрати та фіксована тривалість. 

3.4.6 Як визначаються витрати на завдання? 

3.4.7 Що таке фіксовані витрати на завдання? 

3.4.8 Що таке метод нарахування при розрахунках витрат? 

3.4.9 Що таке контур або профіль завантаження? 

3.4.10 Як визначається вартість проекту? 

3.4.11 Що таке бюджет проекту й що таке витрата бюджету? 

3.4.12 Що таке базовий план проекту?  
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Лабораторна робота № 4 

Аналіз завантаження ресурсів і оптимізація параметрів проекту 

4.1 Мета роботи 

Отримання практичних навичок проведення аналізу та 

оптимізації завантаження ресурсів та оптимізації параметрів проекту. 

4.2 Основні теоретичні відомості 

4.2.1 Перевантажені ресурси 

Перевантаження ресурсів – це перевищення в процесі 

планування максимально можливого для цього ресурсу обсягу 

призначення, передбаченого в певний проміжок часу. 

Поява в проекті перевантаженого ресурсу може бути викликане 

наступними причинами: 

– призначення ресурсу на завдання в кількості, що перевищує 

максимально припустимий обсяг призначень; 

– одночасне призначення ресурсу на дві або більш завдання, у 

результаті чого сумарний обсяг призначень перевищує максимально 

припустимий; 

– призначення ресурсу на завдання, що виконується в період 

недоступності ресурсу (у його неробочий час). 

Перевищення завантаження ресурсу можна знайти, відкривши 

додаткову панель із виводом Гістограми завантаження ресурсів. 

Графік завантаженості ресурсу представляє собою стовпчасту 

діаграму, у якій на горизонтальній осі відображаються дати, а на 

вертикальній осі вказується обсяг призначень ресурсу (рис. 4.1). 

Чорною лінією позначається рівень доступності ресурсу, тобто 

припустимий обсяг призначень. Рівень завантаження ресурсу, що 

перевищує встановлене для нього максимальне значення, виступає на 

діаграмі за границю чорної лінії. 

4.2.2 Шляхів усунення перевищень завантаження ресурсів 

Вирівнювання ресурсів – це процес реорганізації плану 

проекту з метою ліквідації перевантаженості його ресурсів. 

При виявленні перевищення завантаження ви можете: 

– змінити розподіл працезатрат через профіль завантаження; 

– затримати виконання завдання або вставити в завдання 
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перерву; 

– змінити обсяг призначень ресурсу на завдання; 

– реорганізувати мережний графік робіт; 

– замінити перевантажений ресурс іншим вільним; 

– урахувати наднормативні працезатрати ресурсів як 

понаднормові (не більш 2 – 4 годин на добу). 

 
Рисунок 4.1 – Подання перевантаженого ресурсу 

У деяких випадках може виявитися досить корисним змінити 

робочий час ресурсу за допомогою календаря ресурсу або уточнити 

періоду часу, протягом якого даний ресурс буде задіяний для 

виконання конкретного завдання. Справа в тому, що за замовчуванням 

ProjectLibre уважає, що призначений на завдання ресурс бере участь у 

його виконанні протягом всього часу завдання, від першої до 

останньої хвилини. Щоб указати період часу, протягом якого ресурс 

реально повинен брати участь у виконанні завдання, можна 

скористатися полем Assignment Delay в призначенні Ресурсу. 

Вибір способу вирівнювання перевантаженого ресурсу прямо 

залежить від причини перевантаження. 
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4.2.3 Оптимізація параметрів проекту 

Після того, як сформовано план проекту й обчислено його 

часові параметри й вартість, при наявності часових або грошових 

резервів можна спробувати поліпшити його показники: 

– закінчити проект раніше спочатку наміченого строку при 

збереженні сформованого бюджету; 

– підвищити якість робіт (за допомогою залучення кращих 

ресурсів) за рахунок збільшення бюджету, при збереженні строків 

виконання робіт; 

– підвищити якість робіт за рахунок збільшення часу, що 

приділяється на них, при збереженні бюджету; 

– зберегти розраховані строки виконання робіт, забезпечивши 

економію матеріальних засобів. 

Однак значно більш складні проблеми виникають у тих 

випадках, коли розроблювач проекту одержує план, параметри якого 

не вміщаються в часові й/або бюджетні рамки. 

Для вирішення позначених проблем використовують методи 

оптимізації строків і вартості проектних робіт. Класичними методами 

аналізу й оптимізації плану робіт є методи PERT (Program Evalution 

and Rewiew Technique, техніка оцінки й перегляду програм) і метод 

критичного шляху CPM (Critical Path Method). 

4.2.4 Оптимізація строків проекту 

При оптимізації часових параметрів проекту необхідно 

визначити критичний шлях і спробувати скоротити його. Для цього 

можна застосувати наступні способи:  

– перекриття завдань; 

– планування переробки й/або зміна календарів ресурсів; 

– поділ тривалих завдань на більш дрібні; 

– пошук і виправлення помилок планування. 

Як самий радикальний метод зміни строку завершення проекту 

можна застосувати зміну дати початку проекту. 

4.2.5 Оптимізація бюджету 

При оптимізації бюджету доцільно дотримуватися наступного 

порядку дій. 

1. Виявити завдання, що викликають перевищення бюджету.  
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2. Визначити наявність резервів часу для завдань, які не 

укладаються в бюджет.  

3. Зберегти резервну копію плану,  

4. Скорегувати состав і розподіл ресурсів з метою зниження 

витрат.  

5. Оцінити результати оптимізації плану.  

Засоби, які здатні допомогти менеджерові виявити недоліки 

проекту на етапі планування:  

– фільтри для відбору завдань із перевищенням витрат;  

– звіти про витрати.  

4.3 Завдання на лабораторну роботу 

4.3.1 Відкрийте проект, створений у лабораторній роботі №2. 

4.3.2 Отримайте список ресурсів з перевищенням завантаження. 

Якщо перевантажені ресурси не виявлені, створіть варіант (копію) 

плану, у якому присутні як мінімум два перевантажені ресурси з 

урахуванням наступних обставин:  

– ресурсу призначений на завдання в кількості, що перевищує 

його максимально припустимий обсяг призначень;  

– одночасне призначення ресурсу на два або більше завдання;  

– призначення ресурсу на завдання, що виконується в період 

його недоступності. 

4.3.3 Виконайте аналіз плану для кожного перевантаженого 

ресурсу та сформулюйте способи вирівнювання. 

4.3.4 Усуньте перевантаження ресурсів. 

4.3.5 Підготуйте звіт щодо проведеної оптимізації. 

4.3.6 Збережіть новий базовий план проекту №2. 

4.3.7 Створіть копію отриманого плану проекту й проведіть 

серію експериментів: 

а) перенесіть дату початку проекту на тиждень уперед; внесіть 

зміни в план проекту таким чином, щоб його тривалість 

зменшилася й проект уклався в строк; 

б) визначте критичний шлях проекту; вивчите специфіку 

завдань критичного шляху; змініть план так, щоб зменшити 

число завдань на критичному шляху; 

в) скоротіть тривалість критичного шляху проекту за рахунок 

перегляду і зміни типів залежностей між завданнями; 
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г) скоротіть тривалість критичного шляху проекту за рахунок 

планування робіт у понаднормовий час;  

д) скоротіть тривалість критичного шляху проекту за рахунок 

призначення додаткових ресурсів.  

Додайте до звіту результати трьох експериментів і 

проаналізуйте отримані результати. 

4.3.8 Проведіть огляд витрат в отриманому плані проекту. 

Визначте завдання з перевищенням бюджету. 

4.3.9 Оптимізуйте план у випадку розбіжності вартості етапів і 

робіт із затвердженими витратами, наведеними в проектному завданні. 

4.3.10 Сформуйте звіт про рух коштів по проекту. 

4.3.11 Створіть копію отриманого плану проекту й проведіть 

серію експериментів: 

а) внесіть зміни, у результаті яких отриманий бюджет проекту 

перевищує можливості замовника; тепер вам необхідно 

зменшити бюджет на 10%; для цього ваше керівництво 

дозволяє використовувати більш низькі таблиці норм витрат 

у ресурсів; 

б) визначите, на який з матеріальних ресурсів іде найбільше 

коштів, і яка повинна бути вартість ресурсу щоб знизити 

проектні витрати на 5%; у випадку, якщо вартість ресурсів 

становить менше 5% проектних витрат, збільшити вартість 

ресурсів для проведення аналізу. 

Додайте до звіту результати одного експерименту і 

проаналізуйте отримані результати. 

4.3.12 Підготуйте звіт за лабораторної роботи. 

4.4 Контрольні питання 

4.4.1 Перелічіть причини появи перевантаження ресурсів у 

проекті. 

4.4.2 Яким чином усувається перевантаженість ресурсів? 

4.4.3 Які дії необхідно виконати для оптимізації бюджету 

проекту?  

4.4.4 Які дії необхідно виконати для оптимізації строків 

проекту? 

4.4.5 З якою метою виконують виявлення завдань із 

перевищенням вартості? 



53 

4.4.6 Яким чином здійснюється підвищення рівня доступності 

ресурсу в проекті? 

4.4.7 Яким чином можна скоротити критичний шлях проекту? 

4.4.8 З якою метою проводиться зміна календарів проекту? 
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Лабораторна робота № 5 

Керування виконанням проекту 

5.1 Мета роботи 

Одержання практичних навичок відстеження ходу виконання 

проекту. 

5.2 Основні теоретичні відомості 

5.2.1 Відстеження роботи 

Крім робіт з якісного керування проектом, ефективний керівник 

проекту повинен гарантувати, що мета проекту буде досягнута в строк 

і в рамках бюджету. При відставанні завдань від графіка або 

перевитраті бюджету необхідно переглянути плани проекту, 

перерозподілити ресурси і знайти способи мінімізації впливу на час і 

витрати. 

Важливо зберегти початковий план проекту в якості базового, а 

потім зрівняти його з фактичним. 

ProjectLibre обчислює для завдань розбіжність із базовими 

значеннями дат початку й закінчення, тривалості робіт і витрат. Ви 

можете відобразити цю розбіжність на діаграмі Гантта, натиснувши 

праву кнопку миші й вибравши в контекстному меню, який з базових 

планів повинен бути виведений (рис. 5.1). 

При відстеженні на діаграмі Гантта ProjectLibre показує базові 

завдання сірим кольором, а фактичні або заплановані – синім або 

червоним кольором. 

При регулярному оновленні стану проекту ProjectLibre дозволяє 

менеджерові спрогнозувати дату його завершення. 

5.2.2 Заповнення фактичних даних завдання 

Ви можете змінити більшість даних проекту в списку завдань. 

Цей вид містить поля фактичних початку й закінчення, відсоток 

завершення, витрат і тривалості робіт. 

Для того щоб ввести данні в таблицю, необхідно наступне. 

1. Виберіть комірку, у якій необхідно змінити дані. 

2. Якщо це поле типу «Дата», ви можете вибрати дату з 

календаря, натиснувши кнопку зі стрілкою праворуч від значення в 

комірці. 



55 

3. Для введення деяких числових значень (наприклад, %), ви 

можете використовувати кнопки зі стрілками в комірці для 

збільшення й зменшення значень. 

 
Рисунок 5.1 – Відстеження робіт: контекстне меню 

Ви можете вносити значення відсотків виконання завдань у 

таблиці завдань або за допомогою меню [Task » Task » Update]. 

Крім того відсоток виконання можна змінити на діаграмі Гантта. 

При наведенні покажчика на завдання, коли покажчик прийме форму 

знаку відсотка зі стрілкою, натиснути ліву кнопку миші й, не 

відпускаючи її, перемістити показник уздовж відрізка завдання вправо 

на необхідну відстань. При цьому усередині відрізка завдання 

з'явиться темна лінія, довжина якої відповідає чисельному значенню 

параметра % завершення. 

Також можливо оновити відсоток виконання проекту в цілому і  

система автоматично обчислить відсотків виконання всіх завдань 

проекту. Щоб скористатися цією функцією, виберіть у меню пункт 

[File » Project » Update]. 
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5.2.3 Аналіз освоєного обсягу 

Аналіз плану й фактичного виконання обсягу робіт дозволяє 

судити про реальний стан проекту. 

Аналіз освоєного обсягу (Earned value analysis) – це метод 

оцінки ефективності реалізації проекту за критеріями вартості. 

За допомогою методу освоєного обсягу здійснюють контроль 

наступних трьох ключових показників. 

Базова вартість запланованих робіт (BCWS, Budgeted Cost of 

Work Scheduled) або погодинні витрати за базовим планом від початку 

проекту на поточну дату (current) або контрольну дату (status) звіту: 

 BCWS = базова вартість години * кількість базових годин. 

Базова вартість виконаних робіт (BCWP, Budgeted Cost of 

Work Performed) або базова вартість фактично витрачених годин, 

обчислена в припущенні, що ставка оплати ресурсів відповідає 

плановій (освоєний обсяг): 

 BCWP = базова вартість години * фактична кількість годин. 

Фактична вартість виконаних робіт (ACWP, Actual Cost of 

Work Performed) або фактичні витрати, понесені для завдань: 

 ACWP = фактична вартість години * фактична кількість годин. 

Щоб подивитися значення показників, необхідно в таблицю 

завдань додати ці стовпчики (BCWS, BCWP, ACWP). Крім того 

показники засвоєного обсягу можуть бути отримані у вигляді звіту 

(Task Information » Earned Value). 

Ці три значення використовуються для розрахунків наступних 

показників, які й відображають результати аналізу. 

Індекс виконання бюджету або індекс відхилення вартості 

(CPI, Cost Performance Index) - показує відношення освоєного обсягу 

до фактичних витрат: 

 CPI = BCWP / ACWP. 

CPI показує, наскільки добре проект укладається в бюджет: 

– CPI > 1, вартість нижче, чим було заплановано; 

– CPI < 1, вартість вище, чим було заплановано. 

http://www.kostigoff.ru/projectlibre.15/glossary.html#term-bcws
http://www.kostigoff.ru/projectlibre.15/glossary.html#term-bcws
http://www.kostigoff.ru/projectlibre.15/glossary.html#term-bcwp
http://www.kostigoff.ru/projectlibre.15/glossary.html#term-bcwp
http://www.kostigoff.ru/projectlibre.15/glossary.html#term-acwp
http://www.kostigoff.ru/projectlibre.15/glossary.html#term-acwp
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Індекс виконання розкладу або індекс відхилення від 

календарного плану (SPI, Schedule Performance Index) - показує 

відношення освоєного обсягу до запланованих витрат: 

 SPI = BCWP / BCWS. 

SPI показує, наскільки добре проект укладається в розклад: 

– SPI > 1 показує, що проект випереджає розклад; 

– SPI < 1 показує, що проект відстає від розкладу. 

Відхилення по витратах (CV, Cost Variance) – це величина, що 

відображує різницю фактичної й планової вартості виконаних робіт: 

 CV = BCWP – ACWP. 

Його значення: 

– CV>0 показує економію бюджету; 

– CV<0 показує перевищення бюджету. 

Відхилення від графіка (SV, Schedule Variance) - визначає 

різницею між плановою вартістю робіт із графіка виконаних робіт і 

плановою вартістю: 

 SV = BCWP – BCWS. 

Вимірює, наскільки в грошовім вираженні виконання проекту 

випереджає або відстає від плану: 

– SV>0 показує, що виконано більше робіт, чим заплановано; 

– SV<0 показує, що виконано менше робіт, чим заплановано. 

Чим більша величина показників SV і CV, тим більше різниця 

між реальною продуктивністю й планами. 

Бюджет по завершенню (BAC, Budget At Completion) – обсяг 

кошт запланованих на проект: 

 BAC = sum (BCWS) 

Оцінка по завершенню (EAC, Estimate At Completion) – 

очікувана вартість проекту по завешенню: 

 EAC = BAC / CPI. 

Відхилення по завершенню (VAC, Variance At Completion) – 

очікувана перевитрата або економія бюджету: 
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 VAC = BAC – EAC 

Оцінка до завершення (ETC, Estimate To Completion) – скількі 

коштів необхідно до завершення проекту: 

 ETC = EAC – ACWP. 

5.2.4 Подання Діаграма Гантта 

Розглянемо це подання як засіб контролю над дотриманням 

планових строків. 

Для відстеження відхилення поточного положення проекту від 

базового необхідно відкрити Диаграму Гантта й додати в таблицю 

наступні колонки:  

– Початок - поточна (зазначена в розкладі) дата початку 

виконання завдання;  

– Закінчення - поточна (зазначена в розкладі) дата завершення 

завдання;  

– Початок базового плану – дата початку завдання, збережена 

в базовому плані;  

– Закінчення базового плану - дата завершення завдання, 

збережена в базовому плані;  

– Зсув початку – величина відхилення (за замовчуванням - у 

днях) дати початку виконання завдання від планової дати (позитивне 

значення вказує на затримку початку виконання завдання в порівнянні 

з базовим планом, негативне - на достроковий початок завдання) 

– Зсув закінчення – величина відхилення (за замовчуванням - у 

днях) дата завершення завдання від планової дати; позитивне 

значення вказує на затримку завершення завдання в порівнянні з 

базовим планом, негативне - на дострокове завершення завдання.  

 
Рисунок 5.2 – Вартість проекту й базова вартість проекту 
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5.3 Завдання на лабораторну роботу 

5.3.1 Відкрийте проект, створений у попередній лабораторній 

роботі. 

5.3.2 Встановіть поточну дату та статусну дату. 

5.3.3 Виконайте введення фактичних параметрів робіт. Для 

цього спочатку за допомогою табл. 5.1 визначте перелік робіт, які 

повинні бути виконані на поточну дату. 
 

Таблиця 5.1 Варіанти завдань 

Відсоток (%) виконання проекту (за часом) 

Вар. 1 Вар. 2 Вар. 3 Вар. 4 Вар. 5 Вар. 6 Вар. 7 

25 30 35 40 45 50 55 

5.3.4 Для визначених завдань проекту введіть фактичні дані 

робіт (дати початку та закінчення, тривалість, трудовитрати). При 

цьому хоча б одну з робіт позначте як таку, що було виконано швидше 

за часом, та хоча б одну як таку, що запізнилася з виконанням. 

5.3.5 Проаналізуйте виконання проекту за допомогою методу 

освоєного обсягу. 

5.3.6 Підготуйте звіти, що відображають виконання проекту й 

відхилення від базового плану проекту: Task Information=>Cost, 

Information=>Earned value, Information=>Earned value – Cost,  

Information=>Earned value – Schedule, Information=>Schedule variance,  

Task Information=>Tracking. 

5.3.7 Переплануйте план проекту відповідно до його поточного 

стану. 

5.3.8 Підготуйте звіт до лабораторної роботи. 

5.4 Контрольні питання 

5.4.1 Якими параметрами характеризується фактичне виконання 

робіт, звідки беруть їхні значення, і як ці значення вводяться в проект? 

5.4.2 Що приводить до відхилення фактичних працезатрат від 

планових? 

5.4.3 Що таке базова вартість запланованих робіт? 

5.4.4 Що таке базова вартість виконаних робіт? 

5.4.5 Що таке фактична вартість виконаних робіт? 

5.4.6 Що таке індекс виконання бюджету або індекс відхилення 

вартості? 
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5.4.7 Як розрахувати індекс виконання розкладу або індекс 

відхилення від календарного плану? 

5.4.8 Як розрахувати  відхилення від графіка? 

5.4.9 Як розрахувати  відхилення по витратах? 

5.4.10 Яку інформацію про хід проекту одержує менеджер 

проекту, використовуючи метод освоєного обсягу? 

5.4.11 Що таке бюджет по завершенню, оцінка по завершенню, 

відхилення по завершенню та оцінка до завершення? 
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Додаток А 

Проектне завдання 

1. Назва проекту: Створення офіційного веб-сайту 

підприємства «Компанія» 

2. Головна мета проекту – підвищення ефективності роботи 

компанії. 

Мети проекту: підвищення рівня поінформованості потенційних 

клієнтів про переваги пропонованих послуг; забезпечення зв'язку 

клієнтів з компанією; залучення уваги клієнтів до найцікавіших 

пропозицій компанії. 

3. Планові строки 

початок робіт: 1 вересня 2014 р.  

закінчення робіт: 26 грудня 2014 р. 

(17 тижнів) 

4. Замовник: підприємство «Компанія» 

5. Виконавець: підприємство  «Студент» 

6. Склад робіт 

Найменування етапів і робіт, їх орієнтовну тривалість 

представлено в табл. А.1 ( на підставі наявного досвіду виконавця). 
 

Таблиця А.1 – Склад і тривалість робіт проекту 

№ Назва роботи 
Тривалість, 

день 

1 Проект  

2 Аналіз вимог  

3 Аналіз предметної області, інтерв'ювання клієнта 6 

4 Розробка й затвердження концепту сайту 2 

5 Планування проекту 3 

6 Складання ТЗ 5 

7 Затвердження ТЗ 2 

8 Завершення аналізу вимог 0 

9 Проектування  

10 Розробка дизайну за затвердженим концептом 7 

11 Проектування архітектури сайту 3 

12 Проектування БД 3 

13 Завершення проектування 0 
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Продовження таблиці А.1 

№ Назва роботи Тривалість, 

день 

14 Програмування й верстка  

15 Верстка шаблонів сторінок 32 

16 Розробка бази даних 5 

17 Програмування 40 

18 Заповнення сторінок і тестування на реальних даних 14 

19 Доробка коду, виправлення помилок 7 

20 Завершення програмування й верстки 0 

21 Запуск і супровід  

22 Створення пакета передачі 2 

23 Підготовка платформи 1 

24 Заливання контенту 1 

25 Перевірка якості 3 

26 Здача сайту замовникові 1 

27 Закриття проекту 1 
 

Розглянемо короткий зміст етапів робіт у їхній технологічній 

послідовності для визначення зв'язків між завданнями. 

Аналіз вимог. На даному етапі спочатку здійснюється аналіз 

предметної області: виявлення потреб майбутніх користувачів; 

визначення технічних вимог, що включають вимоги до структури 

сайту, змісту розділів і підрозділів; визначення вимог до дизайну; 

визначення вимог до структури й функцій програмних модулів; 

визначення вимог до архітектури, системи керування контентом сайту 

тощо. 

За результатами аналізу складається концепт сайту, який 

обговорюється із Замовником і командою розробників проекту.  

Після затвердження концепту розробники приступають до 

детального аналізу й формування вимог до розроблюваної системи. 

Паралельно з розробкою ТЗ здійснюється планування проекту, 

що передбачає визначення составу й строків здійснення робіт, 

ресурсів і бюджету проекту. 

Отримані результати приводяться в технічному завданні, яке 

затверджується Замовником. 
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Проектування. Дизайн сайту повинен відповідати 

встановленим цілям і бути функціональним. 

Для створення ескізів дизайнер аналізує концепт і технічне 

завдання. 

На даному етапі також проводиться проектування архітектури 

сайту й проектування бази даних згідно ТЗ. 

Програмування й верстка. Верстка шаблонів сторінок 

здійснюється відповідно до керівництва зі стилю оформлення. 

Паралельно з версткою починається розробка бази даних, після 

чого виконується реалізація спроектованої системи. 

Заповнення сторінок контентом і тестування на реальних даних 

повинні початися за 10 днів до завершення програмування. Роботи з 

верстки до цього моменту вже повинні бути закінчені. 

Доробка коду й виправлення помилок здійснюється відразу 

по завершенню програмування й наповнення. 

Запуск і супровід. До передачі Замовникові й запуску сайту 

необхідно сформувати комплект документації («пакет передачі»), що 

включає всі вихідні файли, зображення, шаблони, інструкції та ін., 

необхідні особі, яка буде супроводжувати сайт після його 

впровадження. 

Одночасно з формуванням пакета передачі проводиться 

підготовка платформи: розміщення сайту на хостинговому сервері, 

налаштування й підтримка DNS. 

Потім здійснюється перенос сайту (заливання контенту) на 

сервер Замовника. 

Після успішного розміщення на сервері сайт тестується ще раз 

для усунення помилок, пов'язаних з особливостями розміщення. 

Після завершення всіх робіт у встановлений термін з 

необхідним рівнем якості Замовник підписує акт про впровадження, 

здійснює взаєморозрахунок з Виконавцем згідно з договором. 

Керівник здійснює закриття проекту. 

7. Планові строки етапів робіт 

Планові строки етапів робіт установлювалися на основі аналізу 

обсягу робіт і наявного досвіду створення аналогічних проектів 

Виконавцем і наведено в табл. А.2. 
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Таблиця А.2 – Строки виконання етапів робіт проекту 

№ Найменування етапу робіт Строки виконання Тривалість 

1 Аналіз вимог 1.09.14-21.09.14 15 

2 Проектування 22.09.14- 30.09.14 7 

3 Програмування й верстка 1.10.14- 17.12.14 56 

4 Запуск і супровід 18.12.14-25.12.14 6 

5 Закриття проекту 26.12.14 1 

 Усього 85 
 

8. Трудові ресурси проекту 

Список трудових ресурсів, необхідних для виконання проекту, і 

їх вартість наведені в табл. А.3. Матеріальні ресурси повинні бути 

сплановані студентами самостійно. 
 

Таблиця А.3 – Список трудових ресурсів 

№ Назва ресурсу (роль) Стандартна ставка грн/година 

1 Керівник проекту 40 

2 Аналітик 37 

3 Дизайнер 30 

4 Верстальщик 27 

5 Програміст Senior 37 

6 Програміст Middle 35 

7 Програміст Junior 30 

8 Тестер, редактор-копірайтер 25 

9 Системний адміністратор 37 
 

8. Орієнтовна вартість етапів робіт 

Вартість етапів робіт визначалася за аналогією з реальним 

проектом створення сайту . Вартість етапів проекту наведена в табл. 

А.4. 
 

Таблиця А.4 – Вартість етапів робіт 

 Найменування етапу робіт Вартість, тис. грн 

1 Аналіз вимог 6 

2 Проектування 4 

3 Програмування й верстка 37 

4 Запуск і супровід 3 
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9. Бюджет проекту: 50 тис. грн. 

10. Матриця завдань і відповідальності 

Матриця завдань і відповідальності встановлює зв'язок між 

роботами, визначеними в структурі проекту (табл. А.1), і 

співробітниками (табл. А.3), відображаючи призначення ресурсів на 

виконання завдань (табл. А.5). 

Кожній завдання можуть бути призначені декілька 

співробітників. Ступінь відповідальності співробітників позначена як 

«О» — основна відповідальність, «В » — допоміжна відповідальність. 
 

Таблиця А.5 – Матриця завдань і відповідальності 

Номер 

роботи 

Номер ресурсу 

 1 2 3 4 5 6 7 8 9 

3 В О        

4  В О       

5 О         

6 В О        

7 О В        

10   О       

11  В   О     

12  В    О    

15    О      

16      О    

17     О В О   

18        О  

19       О В  

22 В    О     

23         О 

24     В    О 

25      О В   

26 О         

27 О         

 


